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IntelliPics Studio 3® Button Actions:
Go to Page, Open URL, Open File, Play Sound, Play Movie

With IntelliTools Classroom Suite® running, choose NEW from the File
menu to get to the Navigation Screen. From the IntelliTools Classroom
Suite Navigation Screen, double click New IntelliPics Studio 3.  Next go up
to View and choose Authoring Toolbar, if it is not already showing.

Adding Pages

You are now in the authoring template and have a blank screen in front of
you. Click on the Page Tools button to open the Page Tools toolbar, then
click on New Page (first button) three times. You have just created three
more blank pages. Note: you could also use the second button from the left,
Duplicate Page to make more pages. Duplicate Page not only makes a new
page, but also copies anything on it, including text, graphics, and buttons.

Notice that the Page Arrows at the top right part of the Authoring Toolbar
are now activated, to indicate that there are multiple pages in the document.
At this time in the authoring mode you are able to move back and forth
between pages using these arrow buttons. Go up to View again and make
sure Show Status Bar is selected. Look down in the lower right, and you
will see an indication of the total number of pages and which page you are
on right now.

Click the Previous Page arrow (left arrow) three times so that you are back
to Page 1.  The left arrow should now be grayed out as there are no previous
pages at this point.

Click on the Page Tools button again to close the Page Tool options.
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Adding Background Pictures

Click on the Add Pictures & Backgrounds Button (to the left) and then
click on the backgrounds button (second button from the right with the scene
on the button).  This button is labeled “Show/Hide Backgrounds”. A
toolbar of backgrounds opens to the right.

Note: The arrow at the right end of the Backgrounds toolbar indicates that
further backgrounds are available. Click on a background of your choice.
The background you choose will be inserted into the first page as a
background picture.  Advance to the next page by clicking on the right arrow
(Next Page) on the Authoring Toolbar, and insert another background by
clicking on another background picture.   Repeat this process for Pages 3
and 4.

Next, click on the Previous Page arrow three times to go back to Page 1.
Control – Click on the page to open the Page Properties window. Change
the Page Name from Page #1 to Home. Select Okay to close the window.
We now have your background pictures in place.

Note that you could have selected your own pictures from your hard drive
and inserted them in as backgrounds as well. To do this, Control-Click on
the page to open Page Properties. You need to click on the Page
Background tab if not already selected.  Then click on the Insert from
File button (fifth button from the left with the picture of a file folder on the
button).  Select a picture from your own hard drive and the click Open.  If
it is what you want, click OK and the picture will be inserted as a
background.
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First Button Action: Go To Page…

Now we want to add our first button.  This button will allow the user to
advance from the first page to another page in a non-linear manner by
clicking on the button.

First click on the Page Button Tool (gray button with down arrow) to the
left of the page arrows on the top toolbar.  Then place your cursor on the
page (you will notice a small crosshairs on your screen which will indicate
where the button will be located) and while holding down the “Click” key,
drag the cursor diagonally so that you create a button.  Note: When you
release the mouse button, the Page Button Properties dialogue will open.
Name the button “Go to Page 4”. Leave the dialogue window open.

Next, click on the Actions tab. Note that the default action for Page Buttons

is Play Sound.  You can remove that action if you like at this time.
Scroll down and click next on the Pages line within the left hand box of the
Available Actions window.  Then click on the Go to Page… in the right
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hand box and then ADD Go to Page to the current button’s actions by
clicking on the Add: bar below the two available action boxes.

You next will be presented with a
choice of pages to go to.  Note:
The system will give you a list of
all available pages so you don’t
have to remember each page’s
name or number.  Use the down
arrow on the right to open the
drop down window and select

Page #4. Then click Okay. Click the Lock Position checkbox at the lower
left and click Okay.  Note: You must lock the button into place for the
button actions to work properly.

Now let’s test the button. Click on the button and you will find that you are
now at Page 4. Check the Status Bar in the lower right to confirm this.

Your next assignment is to add a button to Page 4 to take you back to the
home page when it is clicked. Name the button “Return to Home”, then
finish the button following the previous directions. When you are done and
have locked your button, click on it.

Congratulations! You are back to the Home Page.  You now have two
buttons in place that will allow the user to navigate to different non-linear
pages.  This is a very valuable technique when you want a child to read more
about a specific related subject and you have extra material and content
available for them on separate pages.

Finishing Up: Adding the Page Arrows Toolbar

Go up to the View menu, click on it, and then choose Hide Standard
Toolbars. You will notice that your authoring toolbars have disappeared.
Students do not need this toolbar. But let’s look at this activity for a
moment.  Do we have a problem in its design?

The only way a child can navigate this activity now is by clicking the two
Page Buttons we inserted on Pages 1 and 4.  We might also need to have a
way to allow the child to move to the next or previous page in a linear
manner. We could add additional Page Buttons with the specific actions



©2005 Learning Magic, Inc. Tips and Tricks www.learningmagicinc.com

1/21/05 Page 5 of 10

Next Page and Previous Page, but it would be simpler to have the Previous
and Next Page arrows that we saw in the authoring mode available in the
activity. To do that, we will drop in one of the pre-made toolbars from the
library.

Let’s go back up to View and choose the Authoring Toolbar again.  (Close
down the Picture Options by clicking on Add Pictures and Backgrounds if
you haven’t done this earlier).
Next go to the Edit Custom Toolbars button, which is located in the left
corner above the Add Pictures and Backgrounds button. Click on the button
and you will get the Create/Add Toolbar dialogue. Click on Add Toolbar.

An Add Toolbar… window
opens. You want to add a
toolbar from the Standard
Library, so click on that tab.
Scroll down the list of
available toolbars until you
see Page Arrows or press the
“p” key on your keyboard to
take you to the “p” toolbars

quicker. Click on the Page Arrows line and you will see a picture of the
toolbar displayed below.  Then be sure to click the Insert button to insert the
toolbar into your activity.

The Page Arrows toolbar will automatically be inserted in the top left
corner of the page, and two dialogue windows will open. If you like, you
could reposition the toolbar to the sides or to the bottom by dragging it to the
other parts of the frame. Simply hold down the mouse button and drag it
with your cursor to the desired position, then release the “click” key.

But for now just select Done from the upper right of the Create/Add
Toolbar dialogue. Go back to View and Hide Standard Toolbars again.
You now have activity where you have inserted a toolbar from the Standard
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Library and you have added page buttons to allow you to navigate in a non-
linear manner.

Developer’s Hint:  When creating an activity, you should name each page
with its own unique name rather than relying on the automatic Page
numbering system.   If you decide to use the automatic numbering system,
you can potentially run into difficulty if and when you add new pages in the
middle of an activity or when you delete pages.  Page 4 may become Page 3
etc.  You can always see each page and its name by going to the pages/sort
pages menu, but it is easier and safer to name each page uniquely.

Save your activity with an appropriate name by
going up under the File menu and choosing
Save As Activity. Note: You may simply use
the Save option to save to your own workspace
while constructing an activity, but your final
save should be Save As Activity. Only
activities saved with this option can be assigned
to students.

Accessing the Web: The Open URL
Action

Next let’s look at creating a Page Button which will allow you to go out to a
website when the button is clicked.

Advance forward to Page 2 of your document by clicking the Next Page
arrow.  Then reselect the Authoring Toolbar from your View menu.

Choose the Add Page Button tool and create a new button on your screen.
In the Button Properties window, name the button “Open URL”.

Click next on the Actions tab.  Scroll up to the category File in the left hand
box (Available Actions) and click on it to highlight it.  Then either scroll
down until you find the action Open URL… or enter the letter “o” to get
you to the “o” commands quicker.
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Select the action Open URL… and then ADD it to the current button
actions. A dialogue will open. The next step is to type in the URL address of
your choice.  You may want to use something generic like www.google.com
if you don’t have a web address in mind.

Lock the button in place and then click Okay.

Now let’s test the button. Click on the button to see if you are connected to
the Internet. The button will attempt to launch your browser.  When you
close off the Internet site, the program will take you back to the page where
the page button Open URL is resident.

Note:  You can open other files on your computer in a similar manner.
Simply choose the Open File… command rather than the Open URL…
and then select the file name of your choice from your disk directories.
This command is often used to open pre-existing Word, Inspiration, or
other vendor’s files as a support for the IntelliPics Studio 3 activity that
you are creating. You could also open a tutorial in PDF format.

Please Save As Activity again and choose the “Replace” option when
prompted.

Playing A Movie and Sound From A Button

Now let’s advance to Page 3.  Place another button on your screen and name
the button “Play Sound and Movie”.

You can, of course, copy and paste buttons from one page to another if
you like, rather than creating a new button each time. Control-Click the
button you want to copy, then click Okay to close Properties. While the
button is selected, copy it with Control-C. Move to the page where you
want to paste and type Control-V. Control-Click each copy to make
changes. Note: It is important for copies of the same button on multiple
pages to have the same exact name, if the button is part of an overlay.
Check for and remove any appended numbers (i.e., Button #2, #3, etc.)
from the button name.
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The “default” action for a new button is Play Sound, so you do not have to
add this action (unless you have copied the button from another page which
had the Play Sound action removed). However, we do want to edit this
action. Highlight the action Play Sound in the lower Page Button Actions

window. Click the Edit button beside it. In the dialogue that opens, check
the box for Wait for sound to finish playing (before performing the next
Action in list). Then click Okay.

Loading A Sound

Next go to the Sound tab to actually add a sound.  Note that you can have
synthesized sound by checking the synthesized speech button in the upper
window and then typing in the text you want read.

In this case, we want recorded sound.  You have the choice of recording
your own sounds or voices (up to 30 seconds) or importing sounds (wav.
files) from your files.

Click the radio button to
select Recorded Sound
and then click Import. By
default, the Sounds folder
will open. Choose a sound
of your choice by
highlighting it and then
clicking on Open. You will
see the sound you chose
added to the sounds list in
the window under
Recorded Sound. Be sure
it is highlighted there.



©2005 Learning Magic, Inc. Tips and Tricks www.learningmagicinc.com

1/21/05 Page 9 of 10

Adding A Second Action To A Button

Next let’s add Play Movie as a second action.

Under the Actions tab, scroll down the Available Actions list on the left and
highlight the Play category. Scroll down the actions in the window on the
right until you find Play Movie and Add it to the page button actions. Next
go back to the Sound Action and edit it by telling it to wait before
performing the next action.  Lock the button in position, then select Okay.

Now the page button has the appropriate actions and a sound, but you need
to insert a movie into the page to be played.

Inserting A Movie

Click on the Insert Movie button to the left of the Page Button Tool on the
top toolbar.  Then choose a movie of your choice from your available list.

When the movie is brought into the screen, you can reposition it by putting
the cursor onto the movie, holding down the mouse button and dragging the
movie into position. You can then resize it by grabbing the frame’s corners
or sides and resizing the picture.  Tip: Grab one of the corners and drag to
keep the same proportions.

Once you are satisfied, Control-Click on the movie and Lock it into
position. Shortcut: Typing Control-L locks the movie into position if it is
selected.

Now click on your page button to see what happens.  You should have the
button sound play and when it is finished, the movie should play.
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Editing Buttons: Changing the Order of Actions

Now, let’s go back to the button and Control-Click to edit, and change the
order that the actions will occur. Highlight the Play Sound (Wait) action,
and then click Down and then select Okay.

Click on the button again to see the change in the behavior of the button.
The movie will now play first and then the sound (wav.) file will be played.

Finishing Steps

Finally, go back to the View menu and toggle off Show Status Bar. Also
Hide Standard Toolbars.  The Authoring Toolbar will disappear. To
make sure it stays hidden on all computers, go up under the Options menu
and choose the first item, the Settings for your activity. Click on the
Toolbars tab, and click next to Keep Standard Toolbars Hidden. Click
OK.

Under File, choose Save As Activity again and replace with your final
version. You now have a finished template that you can refer back to again
in the future.

Congratulations! You have now learned how to go to pages, open urls,
open files, play sounds (simple) and play movies using page button actions.
You may want to save this activity in your My Work area for further
reference.  You can always go back and control-click on the buttons to see
the actions that are inherent in the button and see the resulting behavior.


